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Preface 
Purpose of the Lab Manual 

 
 

Pix4D is a Swiss company which started in 2011 as a spinoff of the École Polytechnique Fédérale 

de Lausanne (EPFL) Computer Vision Lab, Switzerland. Pix4D develops a suite of software 

products that use photogrammetry to transform imagery into numerous 2D and 3D deliverables 

and that perform analytics to extract essential information. 

 
 

The Lab Manual was written to help educators and students in higher education become proficient 

at using Pix4Dmapper. It focuses on the desktop version of the Pix4Dmapper software 

(Pix4Dmapper Cloud is not part of this lab). Therefore, all labs in this manual are designed for 

working in a local environment. 

 
 

Labs have been structured to follow a standardized processing workflow. It is recommended that 

students perform each lab in the order as written. This will ensure that students understand the 

fundamental importance of following a systematic workflow. 

 
 

Who is the Lab Manual intended for? 
 
 

Pix4D is proud of the wide adoption of Pix4Dmapper in academia. We were motivated to write this 

manual to support professors and teachers, and to give them a guideline for a Pix4Dmapper 

curriculum. This manual was written for academia and should only be used for educational 

purposes in a classroom environment. 
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How to use the Lab Manual 
 
 

● There are 8 labs in this manual. 

● Labs are written to be independent from one another. 

● Every lab is meant to highlight a series of specific software tools and techniques. 

● All labs include a unique dataset. 

● Labs are broken into sections. Each section follows the previous. 

● Bold text indicates a command to the student. For example: “Click the Apply button” is a 

software technique that the student should follow. 

● Italicized text indicates an important tip, question/answer, or note. 
 
 
 

Data for the Lab Manual 
 
 

Datasets may be directly downloaded from this link. 
 
 
 

Copyrights 
 
 

The information contained in this document is the exclusive property of Pix4D. This work is 

protected under Swiss copyright law and other international copyright treaties and conventions. 

This work is intended to be used for educational purposes and may not be reproduced or 

transmitted in any form or by any means, electronic or mechanical, including photocopying and 

recording for commercial purposes. 

 
 

Citations of the Lab Manual 
 
 

The Lab Manual may be cited for future publications. Please indicate the author (Pix4D SA), title 

(Lab Manual for Pix4Dmapper, 1st Ed.), and date (June, 2019) when citing. 

https://drive.google.com/drive/folders/1DmU5-UjdD6vsil0tSJe2H0es6So_vX5k?usp=sharing
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Feedback about this Lab Manual 
 
 

Feedback is highly appreciated and helpful to future Lab Manual editions. Please fill this feedback 

form to provide direct feedback to the Pix4D team. 

 
 

Information about Pix4D software, licenses, and purchases 
 
 

Pix4D maintains flexible offers of Pix4Dmapper to academia. For more information and to  

purchase educational licenses, please visit our website or contact sales@pix4d.com. 

 
 

Additional Pix4D Support 
 
 

Additional Pix4D support is available beyond the Lab Manual. Please visit support.pix4d.com for 

free access to videos, technical articles, forums, and email help. 

 
 

Additional Pix4D Training and Pix4D Certification 
 
 

Additional Pix4D Training is available beyond the Lab Manual. Please visit training.pix4d.com to 

learn about our flexible training opportunities. There, you can also learn more about how to become 

Pix4D Certified. 

 
 

Contributors 
 

The Lab Manual has been created by Pix4D staff, originally drafted by Jeffrey Miller. Revisions by Martin 

Rehak, Justine Cuevas, Ana Soares, Nikoleta Guetcheva and Alessandro Gallo. 

https://pix4d.formstack.com/forms/educurriculumfeedback
https://pix4d.formstack.com/forms/educurriculumfeedback
https://cloud.pix4d.com/store/?&solution=edu&solution_edu
mailto:sales@pix4d.com
https://support.pix4d.com/hc/en-us
https://www.pix4d.com/services/training-certification
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Thank you for using Pix4D! 
 
 

We are truly grateful that you have decided to teach and learn about Pix4Dmapper! We hope you 

find the Lab Manual useful for your curriculum. Thank you for your continued support and 

ambassadorship! 
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Lab 1 
Photogrammetry & Image Capture 

 
Learning Objectives 

 
● Define ground sampling distance (GSD) 

● Comprehend resolving power and spatial resolution 

● Understand the factors which determine GSD 

● Perform GSD calculations 
 
 
 
 

Abstract: 
 

We begin our course by discussing the fundamentals of photogrammetry and image capture. A 

comprehensive understanding of this subject will ensure pilots are prepared to plan and fly drone 

missions for successful image capture. 

This lab is written under the assumption that each educational institution will have a different fleet of UAS 

and sensor payloads. In addition, Pix4Dmapper is sensor agnostic, meaning the software will process 

images captured from virtually any camera. 

The purpose of the lab is to develop an understanding of the relationship between camera specifications 

and real-world scenarios. This will enable students to plan missions without the need of an app or 

specific camera. This will be accomplished by working through a series of math problems. 
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1.1 What is Ground Sampling Distance: 
 

The Ground Sampling Distance (GSD) is the distance between two consecutive pixel centers measured on 

the ground. For instance, a GSD of “10 cm” means that the length of the pixels in that image translate to 

10 centimeters on the ground (or on whatever object is being photographed). See the figure below: 

 
 

 
 
 
 

The distance between the two consecutive pixels centers represents 10 centimeters in the real-world. The 

GSD in this image is of 10 cm. 

 
 

When comparing different GSD, we can observe different resolutions. For example, an image with GSD of 

5 cm (A) will contain many small pixels compared to an image with a GSD of 30 cm (B). Which example 

contains more details? See the figure below: 

 
 

 

A B 

The resolving power of A is much higher than B as you can gather more detail (i.e. features appear 

clearer). In addition, A has a finer spatial resolution than B. It is important that we define spatial resolution 

as either fine or coarse instead of good or bad. This is because, for all intents and purposes, B could very 
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well be the better solution if all that is needed is an overview for land-use applications. It will require far 

less effort to derive B than A. 
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1.2 The Factors that Determine GSD: 
 

There are three factors to consider when determining GSD: 
 

1) The first is the altitude (H) above ground or the distance that the camera is from an object. To put it 

simply, the closer you are to the ground, the finer the spatial resolution; the further you are from the 

ground, the coarser the spatial resolution. 

 
 

 
 
 

Q: Assume we flew two separate missions. One at an altitude (H) of 100 ft and the other at 1,000 ft. 

Match A and B to the proposed altitudes: 

100 ft    
 

1,000 ft    
 

Altitude (H) - GSD Examples 



Licensed to : University, professor Copyright © 2019 Pix4D. All rights reserved 11  

 
 

 
 
 
 

2) The second factor is focal length (f). The focal length is the distance between the lens and the image 

sensor when the subject is in focus, usually stated in millimeters (mm)(1) . Think of this as how far 

zoomed-in you are to an object. The further zoomed-in, the longer the focal length. It is not advised to 

adjust the zoom of your camera when capturing images. We want our zoom to be fixed to the furthest 

possible zoom available. We measure focal length (f) in mm. See the figure below for an example: 

https://imaging.nikon.com/lineup/dslr/basics/19/01.htm
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Assuming both missions were flown at the same altitude, B is a shorter fixed focal length and A is a longer 

focal length. 

 
 

3) The last factor that determines GSD is the image sensor format. In digital photography, the image 

sensor format is the shape and size of the image sensor(2). The size of the image sensor format will 

determine the image sensors fixed pixel size (ps). A rule of thumb is that the larger ps have a higher 

dynamic range meaning they can adjust to changes in light better than smaller ps. In other words, a larger 

image sensor is superior to a smaller image sensor. We measure ps in μm (micrometers). See the figure 

below for an example: 

 

(3) 

https://en.wikipedia.org/wiki/Image_sensor_format
http://www.astrosurf.com/re/st7.html
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1.3 GSD Calculator 
 

Each of the latter factors has a direct effect on determining GSD. If we treat each factor as a separate 

variable, we can plug their values into the following formula to determine what our GSD will be: 

 
 

● GSD = Ground Sampling Distance 

● H = Altitude 

● f = Focal Length 

● ps = Fixed Pixel Size 
 
 
 

IMPORTANT: Assume we are working in metric units. It is important to convert all variables to mm before 

doing computation. 

 
 

GSD = H ÷ (f/ps) 
 
 

Quick Conversion: 

1 cm = 0.39 in 

1 in = 2.54 cm 
 

1 m = 3.28 ft 

1m = 1000 mm 

1 ft = 0.305 m 

1 mm = 0.1 cm 
 

1 cm = 10 mm 
 

1 μm = 0.001 mm 
 

1 mm = 1000 μm 
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Focal length (f) and fixed pixel size (ps) will need to be known. Altitude (H) is dynamic, meaning it can 

vary from mission-to-mission. 
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GSD Questions: 
 
 

Assume we are flying a DJI Phantom 4 Pro UAS. Ps = 2.3 μm and f = 8.6 mm. 
 
 
 

 (4) 
 
 

1. What is the GSD in cm at an altitude of 100 m? 
 

GSD = (100 m * 1,000 mm) ÷ (8.6 mm/(2.3 μm * 0.001 mm)) 

GSD = 100,000 mm ÷ (8.6 mm/0.0023 mm) 

GSD = 100,000 mm ÷ 3,739.1 mm 
 

GSD = 26.7 mm * 0.1 cm 

GSD = 2.67 cm 

 
 

2. What is the GSD in inches? 
 

GSD = 2.67 cm * 0.39 in 

GSD = 1.04 in 

 
 

3. What is the GSD in inches at an altitude of 57 ft? 
 

GSD = (57 * 0.305 m) ÷ 3,739.1 mm 
 

GSD = (17.385 * 1,000 mm) ÷ 3,739.1 mm 

GSD = 17,385 mm ÷ 3,739.1 mm 

GSD = 4.65 mm 

https://www.dji.com/phantom-4-pro
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GSD = 4.65 mm * 0.1 cm 

GSD = 0.465 cm * 0.39 in 

GSD = 0.18 in 

 
 

4. Which altitude will give a finer spatial resolution and why? 
 
 
 

References 
 
 
 

1. https://imaging.nikon.com/lineup/dslr/basics/19/01.htm 

2. https://en.wikipedia.org/wiki/Image_sensor_format 

3. http://www.astrosurf.com/re/st7.html 

4. https://www.dji.com/phantom-4-pro 

https://imaging.nikon.com/lineup/dslr/basics/19/01.htm
https://en.wikipedia.org/wiki/Image_sensor_format
http://www.astrosurf.com/re/st7.html
https://www.dji.com/phantom-4-pro


Licensed to : University, professor Copyright © 2019 Pix4D. All rights reserved 17  

 

Lab 2 
 

Getting Started with Pix4Dmapper 

 
Learning Objectives 

 
● Learn how to unzip, copy data, and the template folders 

● Create a new project using the Project Creation Wizard 

● Understand how to process Step 1 

● Become familiarized with navigating the rayCloud 
 
 
 

Abstract 
 

This lab will introduce students to Pix4Dmapper, the desktop based processing (aka: local processing) 

software. Pix4Dmapper is the backbone to the suite of Pix4D products. 

Pix4Dmapper is a photogrammetry processing “engine.” It is designed to process images to derive 

deliverables like orthomosacis and 3D models. The processing workflow follows 3 unique Steps. This 

simplistic approach makes the processing of imagery virtually automated. 

Pix4Dmapper enables numerous opportunities to change the specifications of a project. The first 

objective of this lab is to create a New Project from scratch. This is accomplished through the Project 

Creation Wizard. We will walk through each necessary window in the wizard. The second objective will be 

to gain experience working in the rayCloud, Pix4Dmapper’s unique data view. Students will learn how to 

navigate throughout the rayCloud. 
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2.1 The Data 
 

We will create a new project from 100 images captured from a UAS. The images are located in the 

L2_Data.zip folder. 

1. Create a *Your Last Name_Pix4D folder on your local computer. 

2. Within your *Last Name_Pix4D folder create a *L2 folder. 

3. Either by means of handoff from your professor or by direct download, copy the L2_Data.zip 

folder to your machines local hard drive. 

4. Open the L2_Data.zip folder and unzip or copy the L2 folder and paste it within *Your Last 

Name_Pix4D folder. 

5. The images for the project are found in the 01_Images folder. 

6. We are now ready to create a New Project in Pix4Dmapper. 
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2.2 The Project Creation Wizard and Step 1 
 

1. Open Pix4Dmapper (double click the white icon on your desktop). 
 
 
 

2. Enter your institutions email and password credentials and click the green Login button. 
 

 
 

3. Choose Pix4Dmapper from your available licenses. 
 

IMPORTANT: Do not select the button that says Pix4Ddiscovery. 
 
 
 

4. If prompted, accept the User License Agreement. 
 
 
 

5. You have now entered the Pix4Dmapper Home screen. 
 

The following explains what each button does: 
 

1) The current open tab. This tab allows you to create new projects, open existing 

projects, and open the recent 4 projects. 

1A) We will explore this momentarily. 
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1B) We will explore this momentarily. 
 
 
 

2) The Help Tab. When clicked, numerous help tabs appear including the video academy, 

sample projects, and the knowledge base. A very direct resource for finding technical 

help. 

3) The Demo Project. An already-processed project which you’re free to practice with. 
 

4) The 4 most recent projects. Will change if either the Help or Demo Project tab are 

selected. 

5) The latest Pix4D related News. 
 

6) The latest Pix4D related Tips. 
 
 
 

 
 
 

6. Click the New Project button. 
 
 
 

7. You are prompted to give this project a unique name. Let’s call it “*Last Name_L2.” 

● Be very careful to avoid using spaces or any special characters when naming a project. 
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8. Below the name, you are prompted to save your project via the Create In path. 

● DO NOT accept the default path. Instead, we will use the 02_Project folder which was 

included in the L2_Data folder. 

● Click the Browse… button. Navigate to your 02_Project folder. Highlight the folder and 

click the Select Folder button. 
 

 
 

● Your path should be redirected to your 02_Project folder. 

9. Ensure the New Project is selected for Project Type then click the Next button. 
 
 
 

10. We will now add images to the project. 

● Click the Add Images… button. 

● Navigate to your 01_Images folder. 

● Select all of the images by holding the Ctrl + A keys. Clock Open. 

● The images should populate within the wizard. There should be a green check-mark at 

the top left of the screen. It should say 100 images selected. Click Next to continue. 
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11. The next window is Image Properties window. You will see information about the image geotags 

and a table for each images latitude, longitude, altitude, and orientation. We will explore this in 

more detail during Lab 3 of the Manual. For now we can continue by clicking the Next button. 
 

 
 

12. The next window is the Output Coordinate System. This will determine the georeference of our 

deliverables. We will explore this more duringLab 3 of the Manual. For now we will accept the 

default coordinate system and metric units. Continue by clicking the Next button. 

 
 

13. The last window is the Processing Options Template. Here we can choose a predetermined set of 

processing parameters called Templates. We will select the Standard: 3D Maps template from 

the left side of the screen. 
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14. Ensure the Start Processing Now checkbox is unchecked. See the figure below. You are now 

ready to click the button Finish to move on. 
 

 
 

15. With the completion of the wizard, the Map View opens next. Here we see a satellite basemap 

and the images that were captured for this project. Click and hold your mouse to pan the map. 

Use the scroll wheel of your mouse to zoom the map in and out. 

 
 

16. The red dots represent the image locations. Move your move over one of the dots. Notice your 

pointer becomes a finger. Click on a random dot and you will open one of the images for 

visualization purposes. 
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17. We are ready to begin processing of Step 1. 

● Ensure the Processing button is enabled at the bottom left of the screen. 

● Ensure that ONLY THE CHECKBOX FOR STEP 1 IS CHECKED. 

● Click the Start button. 
 

 

18. Notice the software has two processing progress bars. The top is a sub-step and the bottom is 

the progress of the overall enabled Step. Once a sub-step is finished, the overall progress will 

update with 1/8, 2/8, etc. 

 
 

 
 
 

19. Once Step 1 is complete, a Quality Report will appear. This report appears after any 

Step is run. For now, dismiss the report by closing it. 

 
 

20. Notice that the View has changed from the Map View to the rayCloud. Views can be 

toggled back and forth by enabling the buttons on the far left of the screen. 

 
 

21. It is now time to discuss the rayCloud. See the figure below for an explanation of the 

rayCloud: 
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1) Tabs: The various Tabs at the top left of the screen enable you to perform processing 

tasks, file management, and view tasks. Many of the tasks found in Tabs are also 

available as buttons. 

2) View from Top: This plane button enables you to reset your zoom to a nadir view from 

wherever you are on the map. 

3) Navigation Tools: There are various Navigation Modes available. 
 

4) Layers: The Layers are important indicators for what data has been processed and is 

available to view. You have the ability to view Layers by checking its corresponding box 

on or off. Layers that are locked (greyed) will become open after subsequent Steps 

process them. 

5) The Data View: This black background is where the data is visualized and manipulated. 

It is the most used view within the software. We will discuss this in more detail in the 

following sections of this lab. 

6) Properties Window: Every layer contains unique properties. For example, if selected, 

the coordinate values of an automatic tie point will be found in the Selection View within 

the Properties Window. 
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2.3 Navigating within the Data View 
 

The goal is to get you familiar with using different buttons within the Data View. Essentially, this is a 

“play-with-it” time. The more you build your hand-eye coordination, the more efficient you will be at using 

Pix4Dmapper. 

1. Use your mouse to turn on and off different Layers. For example, you can view just the Cameras 

by unchecking all of the boxes but the Cameras. 

 
 

2. Ensure you have the Tie Points Layer checked on. Ensure that the caret (right arrow) for the Tie 

Points is pointed downward. This unveils the GCPS/MTPS & Automatic Layers. Check the 

Automatic Layer on and off. 

Q: What exactly does “Automatic” represent? 

A: The Automatic Tie Points! 

 
 

3. Hover your mouse into the black space of your Data View. 

A. We will operate within the Standard Navigation Mode. This is the default setting. You can 

toggle between different navigation modes by clicking the appropriate button and 

enabling them. 
 

 
B. Try the following tricks with your mouse: 

a.  Click and hold the left click of the mouse and move it around. This will pan the 

dataset around. Think of it like you grabbed your data and you are moving it 

around. 

b.  Click and hold the right click of the mouse and move it around. This will zoom 

your view to the fixed location of your pointer. 

c. Click and hold both buttons of your mouse down and move your mouse around. 

This will rotate your data on a 3D axis. 
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d. Scroll your mouse wheel back and forth. This will provide a dynamic zoom to 

wherever your mouse pointer is located on the screen. 

e. Click the scroll wheel of your mouse like a button and hold it. Move your mouse 

around. Notice this provides the same rotate functionality as both buttons 

clicked. 

f. Hold down the shift key and the left click at the same time. Notice this provides 

the same rotate functionality as both buttons clicked. 

 
 
 

 
 
 

4. Click the Trackball Navigation button at the top of your screen. 
 

 

A. A trackball surrounds your data. Use the left click of your mouse to rotate the data. The 

biggest difference between Trackball and Standard Navigation modes is that the left click 

and both button click functions are switched. 

 
 

5. Click the First Person View button to enable this mode. 
 
 

 

A. Hold down a combination of keys W A S & D on your keyboard. This will enable you to 

pan around your data to a precise view. You can also zoom in with the scroll wheel. The 

right click button is disabled. The left click provide the rotate function. 
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Conclusion 
 

This concludes Lab 2. Hopefully you’ve had time to familiarize yourself with the Project Creation & basic 

navigation of Pix4Dmapper. Being as this is an introduction, there are no deliverables due for this lab. 

Your task this week is to continue to play within the rayCloud of Pix4Dmapper so that you are efficient in 

the upcoming labs. 
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Lab 3 
Ground Control Points 

 
Learning Objectives 

 
 

● Gain a fundamental understanding of georeference, and control points 

● Learn about the structure of GCPs coordinates 

● Become familiarized with image marking techniques 

● Comprehend how to tie the imagery to the GCPs 
 
 
 

Abstract 
 
 
 

A project’s georeference is a critical component because it answers the question, “where does my project 

exist?” A project may be referenced to some absolute location on Earth, an absolute location in an 

arbitrary world, or be completely independent from a predefined reference. 

 
 

The default setting for Pix4Dmapper’s photogrammetry algorithm depends on dense image matching of 

similar pixels between photos. This is made possible due to the high redundancy of image content thanks 

to image overlap. Therefore, Pix4Dmapper is able to align and orient images strictly based on the latter, 

which in turn, enables the generation of Automatic Tie Points (ATPs). Dense image matching and ATPs 

generation occur in this subsequent order during the process of Step 1. 

 
 

If no georeference is provided, the ATPs (and resulting deliverables) will not contain a defined reference. 

This means that the coordinates will be based on an independent 3D cartesian plane that is unique to that 

specific project. 
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The most commonly provided georeference is known as the direct georeference (DG) obtained from 

image geotags. Each image is “tagged” with a unique latitude, longitude, and altitude which is copied to 

the image metadata. During Step 1, Pix4Dmapper accounts for DG of each image to provide an absolute 

georeference to the project. 

 
 

A concern about DG is that the absolute accuracy of the georeference will be based on the absolute 

accuracy of the drones GPS/GNSS unit. Units are known as “consumer grade” meaning they meet the 

needs of flying the drone autonomously, but are imprecise by a number of meters (unless the drone is 

capable of DG via RTK or PPK). This is fine if said project does not need to meet strict accuracy 

standards, such as those outlined by the American Society of Photogrammetry and Remote Sensing 

(ASPRS). 

 
 

When DG does not meet accuracy standards, ground control points (GCPs) must be implemented. GCPs 

are 3D coordinates of Earth’s surface collected by professional land surveyors using survey grade 

GPS/GNSS equipment. Each coordinate is “shot” over the center of a target which will later be identified in 

the images. The control is then tied to the images to provide an accurate absolute georeference. If both 

DG and GCPs are implemented in a project, the GCPs will override the DG which will provide a more 

accurate absolute georeference to the project. 

 
 

In this lab, we will learn the technique of marking targets. We will also tie the control to the project to 

ensure the project maintains a georeference. 
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3.1 The Data 
 

We will work with a pre-processed project. The project data and the images are located in the L3_Data.zip 

folder. 

 
 

1. Either by means of handoff from your professor or by direct download, copy the L3_Data.zip 

folder to your machines local hard drive. 
 
 
 

2. Open the L3_Data.zip folder and unzip or copy the L3 folder and paste it within *Your Last 

Name_Pix4D folder. 

 
 

3. Notice that the template folders are already in place. All of the images are within the 01_Images 

folder, and a .p4d file and folder named GCPs are within 02_Project folder. 
 

 
 
 
 

3.2 Opening the Project 
 
 

Since we are given a pre-processed project, we will Open it instead of creating a New Project. 
 

1. Double-click the GCPs.p4d file to open the project directly. 

2. Since Pix4Dmapper does not save relative image paths we will need to tell the software 

the location of our images. This will happen any time data or projects get transferred 

from one computer to another. 
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A. Click the OK button on the prompt. 

B. Navigate your window to the 01_Images folder within the L3 folder. Single-click the 

folder and then hit the Select Folder button. The software will now reference this path for 

the project. 
 

 
 

3. The GCPs project will open and will display the Map View. The project was flown over a small 

park in California. 

 
 

4. Click the rayCloud button to open the rayCloud View. GCP marking is best done in the rayCloud 

View. 
 

 
5. We now see the images and the ATPs. 
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3.3 Coordinates 
 
 

Pix4Dmapper can import GCP coordinates from either a projected coordinate system, or a local 

coordinate system (aka Arbitrary). For this project, the GCPs were projected to the California State Plane 

Zone 3 Coordinate System. All units are in feet. 

1. Open your L3_Data folder. Notice for this project that there is an 03_Control folder present. Open 

the 03_Control folder. 
 
 
 

2. Open the Adv_GCPs.txt in a simple word/text processor. 
 

 
3. The .txt file is separated by commas. Each comma is read as a delimiter in Pix4Dmapper. This 

type of text file is known as a comma separated values (.csv) file. GCPs must be recorded in this 

fashion to be implemented in the software. 

 
 

4. The commas delimit the following information: 
 
 
 

a. ID - This is the label or name of the GCP. 

b. X - This is the easting coordinate. It is equivalent to longitude. 

c. Y - This is the northing coordinate. It is equivalent to latitude. 

d. Z - This is the elevation coordinate. 
 
 
 

5. A .csv with the latter delimiters is all that is needed for GCPs. 
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6. Coordinates may also be ordered as northing, easting, elevation, or Y, X, Z. 
 
 
 

7. Go back to Pix4Dmapper. For L3, the GCPs have already been imported. Verify this by clicking the 

GCP/MTP Manager button located at the top-left side of the screen. 
 

 

8. The GCP/MTP Manager Window will open. Verify that the GCP Coordinate System is the same as 

stated above. Verify that the coordinates are delimited and that they match the Adv_GCPs.txt. 

 
 

9. The coordinate values in each cell may be modified. However, for this exercise, DO NOT change 

any of the values. 

 
 

10. If the GCPs were not present in the project, it is possible to import them by clicking the Import 

GCPs… button. When prompted, select the .txt file which contains the coordinates. For this lab, 

DO NOT Import the GCPs again as this has already been accomplished. 

 
 

11. Click the Cancel button of the GCP/MTP Manager Window and close the dialog. 
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3.4 Marking Images 
 
 

GCPs do not automatically tie the images to the control as soon as they’re imported. They are tied by 

manually identifying the center location of the targets via a technique known as marking. 

1. Locate the GCP/MTPs layer in the Layers Window. Expand the layer so that the ID for each GCP is 

displayed. 
 

 
 

2. Notice the labels are identical to the .txt file mentioned in 3.3. The “(0)” to the side of each ID is 

an indicator of how many images have been marked for each individual GCP. The goal of this 

exercise is to increase those numbers by marking images. 

 
 

3. Select GCP 01 from the Layers Window. The layer should highlight once selected. 
 
 
 

4. Collapse the Selection Window found under the Properties Window. This leaves only the Images 

Window. 
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5. Each thumbnail represents an image in which the software identifies as a corresponder to the 

selected GCP. 

 
 

6. Notice the blue bulleye in each thumbnail. The blue bullseye is the position of the GCP 

coordinates, also known as the initial positions. There should be a slight shift from the center of 

target found in the thumbnails. This is an indication of inaccuracy as the shots were collected 

directly on top of the targets’ center. By marking images, we will override the initial position so 

that the images and control will be tied together more accurately. 

 
 

7. Roll the mouse over the first thumbnail, image 100_0005_0038.jpg. An orange square will outline 

the thumbnail. 

 
 

8. Hit the spacebar of your keyboard. This should make the thumbnail turn into a full-size, or full-

extents image. Leveraging the full-extents, zoom your mouse to the center of the target. Do you 

best to interpret the dead center where the black and white pattern meet one another. 

 
 

9. Once identified, left-click your mouse on the center. This should create a mark. Marks are 

distinguished by a yellow cross surrounded by a cyan square and large yellow circle. 
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10. Hit the spacebar once more to close the full-extents image. Repeat the process to the next image 

to the right. 

Marks may be adjusted by simply left-clicking any part of the image. The last mark made will stick 

as final. 

11. Repeat the process until you have marked at least 10 images. A good rule of thumb is to mark 

between 10-15 images for each GCP. 

 
 

12. Although tedious, you may also mark images directly from the thumbnails. 
 
 
 

13. When finished marking, expand the Selection Window. The Number of Marked Images is 

displayed in the window. Click the Apply button to save your work. 

It is paramount that you hit the Apply button. Otherwise, all of the work put into marking will be 

lost! 

In addition, if you adjust even one mark, the Apply button must be clicked once more. 
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14. Notice that GCP 01 now has the number of marked images displayed in parentheses. If you do 

not see a number different than “0” in parentheses, you did not hit the Apply button. 
 

 

15. Repeat this technique for the remaining GCPs until there are at least 10 images marked per GCP. 
 
 
 

16. When prompted to mark GCP 03, you’ll notice that a conventional target is missing. In its place is 

the corner of a handicap symbol. It is 100% normal to substitute targets features that are fixed to 

the ground as long as they are easily identifiable. Stripes are great examples. 

 
 

17. Mark the inner right corner of the handicap symbol found in image 0061.jpg. 
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18. Repeat this technique for the remaining images of the handicap symbol. Pay close attention as to 

which corner you are marking as the image orientation will change! Mark at least 10 images for 

GCP 03. 
 

 

19. Confirm that all images are marked and applied by referencing the numbers displayed for each 

layer. 
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3.5 Reoptimize 
 

There is another process necessary in order to complete the tie of images to control. In Pix4Dmapper, it is 

a simple command known as Reoptimize. 

1. Locate the Reoptimize button to the top-left of the screen. Click the Reoptimize button. 
 

 
 
 

2. Accept the prompt by clicking the OK button. 

This is a crucial step in the Pix4Dmapper processing workflow. Repotimize will effectively reset the 

project back to the way it was after Step 1. Therefore, ENSURE THAT YOU HAVE PERFORMED ALL 

TECHNIQUES RELATED TO GCPS BEFORE PROCESSING STEPS 2 AND 3. 

 
 

3. Pix4Dmapper will run a sub-step of Step 1 at the bottom of the screen. This sub-step completes 

the tie and eliminates the need to process Step 1 all over again in its entirety. 

 
 

4. If a failure occurs, revisit the marks. The most common mistake is incorrectly marked images. 
 
 
 
 

3.6 Deliverables & Conclusion 
 
 

In Lab 3, we learned about coordinates, GCPs, and how to mark targets. The control was tied to the 

images via the Reoptimize process. 

 
 

1. Click the Project tab and select Save Project As… 
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2. Ensure you are in your 02_Project directory. 
 
 
 

3. Give the project the name “Last Name_L3 and click the Save button. 
 
 
 

4. Allow Pix4Dmapper to save the project. Close Pix4Dmapper when complete. 
 
 
 

5. Navigate to your 02_Project folder for L3. 
 
 
 

6. Select BOTH the *Last Name_L3.p4d file and folder. 
 
 
 

7. Right-click and select Send to -> Compressed to zip the files. 
 

 
 
 

8. Deliver your new *Last Name_L3.zip to your professor. 
 
 
 

9. This completes Lab 3. 
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Lab 4 
The Dense Point Cloud 

 
Learning Objectives 

 
● Understand the definition of point cloud classification 

● Comprehend the function of point groups 

● Perform an automated classification 

● Become familiar with manual classification techniques 

● Learn how to export unique point groups 
 
 
 
 

Abstract 
 

One of the deliverables derived from Pix4Dmapper is the dense point cloud (DPC). The DPC is generated 

by the same means of dense image matching discussed in L1 & L3. The result is a densified 3D collection 

of points that can be opened in a number of 3rd party software for further analysis. 

 
 

The DPC is processed during Step 2. It is imperative that Step 1 is processed before generating the DPC. 

If GCPs are implemented, they must be tied to the images before processing Step 2. 

 
 

The DPC may be segmented or classified into point groups. Each group will represent a distinct feature. 

For example: You may have a group labeled buildings meaning all of the points that are buildings in the 

DPC are meant to represent buildings in reality. There are two approaches to the classification method: 

automated, and manual classification. We will discover both methods in this lab. 
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4.1 The Data 
 

We will work with a pre-processed project. The project data and the images are located in the L4_Data.zip 

folder. 
 
 
 

1. Either by means of handoff from your professor or by direct download, copy the L4_Data.zip 

folder to your machines local hard drive. 

 
 
 

2. Open the L4_Data.zip folder and unzip or copy the L4 folder and paste it within *Your Last 

Name_Pix4D folder. 

 
 
 

3. Notice that the template folders are already in place. All of the images are within the 01_Images 

folder, and a .p4d file and folder named DPC.p4d are within 02_Project folder. 

 
 
 

4. 
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4.2 Opening the Project 
 

Since we are given a pre-processed project, we will Open it instead of creating a New Project. 

 
1. Double-click the DPC.p4d file to open the project directly. 

 
 
 
 

2. Since Pix4Dmapper does not save relative image paths we will need to tell the software the 

location of our images. This will happen any time data or projects get transferred from one 

computer to another. 

a. Click the OK button on the prompt. 

b. Navigate your window to the 01_Images folder within the L4 folder. Single-click the 

folder and then hit the Select Folder button. The software will now reference this path for 

the project. 

 
 
 

3. 

i.  
 
 
 
 

4. The DPC.p4d project will open and will display the Map View. Notice that this project was flown in 

Lausanne, Switzerland. 

 
5. Click the rayCloud View next. You’ll see the ATPs and the camera locations. Use the navigation 

skills learned in L2 to familiarize yourself with the data. 



Licensed to : University, professor Copyright © 2019 Pix4D. All rights reserved 45  

4.3 Automated Classification of the Dense Point Cloud 
 
 

As discussed, we can classify the DPC. In this section, we will learn the automated classification 

technique. 

 
1. Notice in the Layers that the checkbox for Point Clouds is unlocked but not checked. Check the 

box for Point Clouds. 

 
 
 

2. When prompted, check the box for Don’t Display this Message Again and click the OK button. 
 
 

 
 
 
 
 

3. It takes a moment to load and then the DPC will display in the Data View. Notice how much the 

DPC “pops” in your view. 

 
4. Notice that Point Groups layer becomes unlocked. 



Licensed to : University, professor Copyright © 2019 Pix4D. All rights reserved 46  

 
 
 

5. There are 7 predetermined groups. Try checking the boxes for each group and pay close attention 

to your DPC. Does anything change? 

The answer is NO because the automated classification is not performed as a default Processing 

Option. Technically, all of our points are in the Unclassified group. 

 
6. There are 2 ways for us to perform the automated classification: 

 
 

a. If Step 2 HAS been processed (our scenario), the following applies: 
 
 

i. Click the Process tab. This tab enables a number of different sub-steps to be 

processed. Included in this list is the Run Point Cloud Classification sub-step. 

Click Run Point Cloud Classification. 
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ii. Notice the processing of the sub-step occurs. When complete, your DPC will be 

classified and the groups will be populated. 

 
 
 

b. If Step 2 has NOT been processed, the following applies: 

WARNING: DO NOT DO THE FOLLOWING FOR THIS LAB. THIS PART IS ONLY MEANT FOR 

DEMONSTRATION PURPOSES IN REGARDS TO THIS LAB. 

c. 

i. Click the Processing Options button at the bottom right of your screen. 
 
 

 
 
 

d. In the Processing Options window, click the 2. Point Cloud and Mesh tab on the left hand 

side. Check the box for Classify Point Cloud. Click the OK button to close the Processing 

Options. 

 
e. With this parameter set, the automated classification will occur during the processing of 

Step 2. 

 
7. Once you have performed the automated classification we can explore how well the software 

classified the DPC. Check the boxes on and off for the different groups. Evaluate how precise the 

software performed the automated classification. What do you think? 

 
8. It is helpful to turn off the ATP’s from the view. This is done by unchecking the box for the layer 

called Automatic. 
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9. Another perspective for evaluating the automated classification is the display the groups by their 

class color. Click the caret next to the Point Clouds layer. Click the caret next to the Densified 

Point Cloud layer to expand it. Click the caret next to Display Properties. Check the box Show 

Class Color. Evaluate the groups. Does this change your opinion of the performance of the 

automated classification? 
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4.4 Manual Classification of the Dense Point Cloud 
 
 

The automated classification by Pix4Dmapper may result in points being misclassified in the DPC. This is 

normal as there is no perfect automated classification solution. Manual classification will enable us to 

correct any misclassifications and add unique point groups. 

 
 
 

1. Upon review of your DPC, locate an area where you identified misclassifications. The best way to 

do this is to toggle the checkbox Show Class Color on and off. For example: There is a building in 

the center of the project which is classified in multiple groups. Zoom your mouse in closer to this 

building. 

 

 
 
 

2. When zoomed in, we see the building classified as Building (purple), Human Made Object (cyan), 

and High Vegetation (green). We need to correct the erroneous Human Made Object and High 

Vegetation groups by performing manual classification. 
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3. Locate and click the Edit Densified Point Cloud button at the top of your screen. 
 

 
 
 
 

4. Read the prompt. It explains the clicking sequence required to make this tool work. You can 

check the box for Don’t Display This Message Again and click the OK button to continue. 
 
 

5. Use your mouse to digitize a polygon around the entire house. The sequence is to start your 

polygon with the left-click of your mouse. Continue to create vertices for your polygon by using 

the left-click of your mouse. When you are ready to close the polygon, use the right-click of your 

mouse. Do your best to digitize your polygon only around the points that make up the building. 

 
6. Once the polygon is closed, notice the points turn red in color. This tells you that the points are 

selected by you manually, i.e., manual classification. 

 
7. To complete the manual classification, click the dropdown next to the Edit Densified Point Cloud 

button. From the dropdown, click Buildings. Click the Assign button. Congratulations, you have 
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just completed your first manual classification. 
 

8. To confirm these changes, unselect the points in red by clicking the Edit Densified Point Cloud 

button. The points that were selected should now appear purple because they have been 

classified to the Buildings group. It is also helpful to check your group layers on and off to verify if 

the points were classified as intended. 

 

 
 

9. If you make a mistake while performing manual classification, simply redo your polygon and 

reclassify the points. 

 
 
 

10. Notice that the 7 predetermined groups don’t account for every type of feature in a project. Cars 

and fences are two different things in reality, yet Human Made Object is the only predetermined 

group available. The next few steps will enable you to create your own unique groups to classify 

features like the latter. 

 
11. Identify some cars in your DPC. The software does a pretty good job at classifying them as 

Human Made Objects. 
 
 

12. Click the Edit Densified Point Cloud button. 
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13. This time, instead of selecting one of the predetermined groups our task is to click New Point 

Group from the dropdown. 

 
14. When prompted, enter “Cars” in the New Point Groups Name. Click the OK button. 

 
 
 

 
 

15. With Cars populated in the dropdown, any points you select and Assign will be classified within a 

Cars group. Notice that Cars is now one of the layers under Point Groups. 
 
 

Complete this portion of the lab by performing as many manual classifications as class time will 

allow. 

 
 
 
 

4.5 Exporting the Dense Point Cloud 
 

Assume you are satisfied with the manual and automated classification of your DPC. It is now time to 

export the DPC with either all of the groups in one file, or only specific groups in one file. 

 
 
 

1. Within the Layers ensure the caret for Densified Point Cloud is expanded. 
 
 

2. Locate the layer DPC_group1_densified_point_cloud. 
 
 

3. Right-click the layer. Click Export Point Cloud… Ensure you click YES when prompted to save 

your changes. 

CAUTION: IF YOU SAY NO, ALL OF THE CLASSIFICATION WORK WILL BE LOST. 
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4. The next window allows you to select which groups you’d like to include in a written file of the 

DPC. 

 
a. As an example, we will uncheck ALL of the boxes except for Buildings. 

 
 

b. Also, check the box LAS to ensure your write a .las file. 
 
 

c. You are welcome to save your .las file in a specific folder or a specific name by clicking 

the Browse… button, however we will avoid that this time. 

 
d. Click the OK button to finish the export. 

 
 

 
 

5. Pix4Dmapper will process the export and prompt you with the path of your new file. Click the 

Open Folder button. 
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6. Notice the .las file in your folder. You can confirm this is the correct file by the time stamp. 
 
 

7. The new .las file will maintain only the Buildings group. 
 
 

8. This file can be shared and opened in any 3rd-party software capable of opening point clouds. 
 
 
 

4.6 Deliverables & Conclusion 
 

The DPC is a standalone deliverable. Millions of 3D coordinates represents the geometric characteristics 

of a project. Since the DPC was derived from photography, they points maintain the colors of the image 

content. Points may be classified by either manual and/or automated methods to represent unique 

feature groups. 

 
 
 

1. Click the Project tab and select Save Project As… 
 
 

2. Ensure you are in your 02_Project directory. 
 
 

3. Give the project the name “Last Name_L4 and click the Save button. 
 
 

4. Allow Pix4Dmapper to save the project. Close Pix4Dmapper when complete. 
 
 

5. Navigate to your 02_Project folder for L4. 
 
 

6. Select BOTH the *Last Name_L4.p4d file and folder. 
 
 

7. Right-click and select Send to -> Compressed to zip the files. 
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8. Deliver your new *Last Name_L4.zip to your professor. 
 
 

9. This completes Lab 4. 
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Lab 5 
3D Modeling 
Learning Objectives 

 
● Understand the relationship between the DPC and the 3D Textured Mesh 

● Learn how to remove excess noise from the point cloud 

● Comprehend the importance of constraining the project using the Processing Area 

● Discover how to leverage processing shortcuts 

● Learn how to derive the best 3D model 
 
 
 
 

Abstract 
 

In Lab 4 we explored the dense point cloud. The DPC, in actuality, is a 3D model in the sense that it is a 

collection of points with coordinates in both the horizontal and vertical axis. Aside from a standalone 

deliverable, the DPC is considered a “building block” from which numerous other deliverables are built 

from. 

 
The 3D Textured Mesh (3DM) is a deliverable that is generated during Step 2. It is a derivative of the DPC. 

It is composed of an assembly of triangles. The distance between the mesh and the points of the Point 

Cloud is optimized to be minimal, but this means that points of the mesh do not necessarily correspond  

to points of the point cloud. 

 
Since the mesh is 3D, it is unfolded onto a 2D plane in order to define the resolution (pixel size). Then the 

3D position of the pixel is reprojected into the original images to obtain the color. Blending is used instead 

of stitching to generate the texture of the 3D Textured Mesh. The end result is a deliverable that 

resembles what is traditionally called a 3D Model. 

 
Since the 3DM is a derivative from the DPC, it is important that the DPC is classified. When satisfied with 

our classification, it is possible to generate the 3DM as a sub-step.Lab 5 will cover advanced methods of 



Licensed to : University, professor Copyright © 2019 Pix4D. All rights reserved 57  

manual classification with the end goal being that we derive the highest quality DPC. We will then 

discover how to establish a boundary around our dataset to remove unwanted data. All three tasks will 

maximize the final 3DM. 
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5.1 The Data 
We will work with a pre-processed project. The project data and the images are located in the L5_Data.zip 

folder. 

 
1. Either by means of handoff from your professor or by direct download, copy the L5_Data.zip 

folder to your machines local hard drive. 
 
 

2. Open the L5_Data.zip folder and unzip or copy the L5 folder and paste it within *Your Last 

Name_Pix4D folder. 

 
3. Notice that the template folders are already in place. All of the images are within the 01_Images 

folder, and a .p4d file and folder named 3D_model are within 02_Project folder. 
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5.2 Opening the Project 
 

Since we are given a pre-processed project, we will Open it instead of creating a New Project. 

 
1. Double-click the 3D_model.p4d file to open the project directly. 

 
 

2. If prompted, ensure that you set the relative paths for the images just like we did in L4. 
 
 

3. The 3D_model project will open and will display the Map View. Notice that this project was flown 

over a large communications tower in the city of Waterloo, Canada. 

 
4. Click the rayCloud View next. You’ll see the ATP’s and the camera locations. Check the box for 

Point Clouds. Use the navigation skills learned in L2 to familiarize yourself with the data. 
 
 

5. The angle of the photos is oblique instead of nadir. Notice how the extents of the DPC spread far 

beyond the communication tower. 

 
6. Check the box for layer Triangle Meshes. This turns on the layer of the 3DM. 
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7. Observe the quality of the 3DM, particularly where the tower is. Does it appear to be a “clean” 

looking model? 

 
 

Remember, our abstract stated that the 3DM is a derivative of the DPC. This means that the quality of 

the 3DM is directly dependant on the quality of the DPC. The artifacts on the tower are what we call 

noise. Noise is a byproduct of every photogrammetry DPC. It is unavoidable. We can remove the noise, 

however, by using advanced manual classification techniques. 
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5.3 Image Annotations 
 

We have identified that noise from the DPC is the reason our 3DM appears to be low quality. In this task 

we will remove the noise using a tool called Image Annotations. 

 
1. It’s time for us to circle back to the DPC to perform a manual classification of the noise on and/or 

near the tower. 

 
2. Check the Triangle Meshes and the Automatic layers off revealing only the DPC. 

 
 

 
 

3. Locate the top portion of the tower. In the Data View, Left-Click on one of the tower points in the 

DPC. The point will turn red indicating you have selected it. 

 
4. View the properties of the point in the Properties Window to the right side of the screen. 

 
 

5. Notice the photos appears in the Images View. There is a green X in the photos. The green X in 

each photo corresponds to the location of the selected point from the DPC. 
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6. The goal was to select a point on the antenna of the tower. Therefore, the green X should land on 

the antenna in the photos. But it does not do this in every photo. This misalignment is the cause 

of the noise points on the tower. 

7. Use your mouse and Double-click on one of the photos where the green X is misaligned. 
 
 

8. The Selection Window will display the properties of the image. Click the button that looks like a 

pencil. This tool is called Image Annotations. 
 
 

 
 
 

9. The software will take a few seconds to segment the image. This means you can edit the pixels 

of only the selected image. 



Licensed to : University, professor Copyright © 2019 Pix4D. All rights reserved 63  

10. Click the dropdown next to Annotate at the bottom of the Selection View. 
 
 

a. There are 3 different Image Annotation modes: 
 
 

i. Mask - Pixels annotated using Mask will not be used to generate the orthoplane. 

We do not cover orthoplanes in this manual. 

 
ii. Carve - Pixels annotated using Carve will not be used to generate the DPC. 

 
 

iii. Global Mask - Pixels annotated using the Global Mask will not be used to 

generate the DPC and/or the orthomosaic. 

 
11. For this exercise, the Carve Image Annotation mode is the most appropriate. Select Carve from 

the dropdown. 

 
12. The next step is to perform a manual classification using the Carve tool. Hover your mouse over 

the image in the Selection Window. Hit the spacebar button on your keyboard. This will enable the 

full-extents of your image. To exit the full-extents, hit the spacebar button on your keyboard once 

more. 

13. Notice your mouse pointer resembles a pencil. As you move your mouse around, a red chunk of 

pixels at the end of the pencil moves as well. 

 
a. The size of the chunk is dynamic. What is happening is that the chunks are larger or 

smaller depending on how homogenous the pixels are. The more homogenous, the larger 

the chunk of pixels and vise versa! 

 
b. The chunk size will also change based on zoom scale. The closer you zoom in with your 

mouse, the smaller the chunk gets. 

 
14. Click and hold the left-click of your mouse to highlight a chunk of pixels. When you release the 

left-click of the mouse, the highlight action turns off. 
 
 

15. Highlight a number of large chunks in the parking lot in the image. When finished, click the Apply 

button in the Selection Window. Pay close attention to the parking lot points from the DPC. What 

happened to them??? 

They dissapear. You have just performed an Image Annotation. The points are now removed from 
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the DPC. Therefore, we consider this an advanced form of manual classification. See the figure 

below. 

 

 
 
 

16. If you’ve highlighted pixels by mistake, you can unhighlight them by revisiting the annotated 

image. 

 
17. Hover your mouse over the highlighted chunk. Notice that your mouse symbol changes from a 

pencil into an eraser. Click and hold your eraser over the highlighted chunks to unhighlight them. 

This is the only way to undo an image annotation. 

 
18. The goal of this exercise is to highlight the chunks of pixels that were contributing to the noise on 

and near the communication tower. 

19. Remain in the Carve mode and ensure your image is full screen. 
 
 

20. Zoom in to the antenna of the tower. Begin to highlight all of the features that are NOT THE 

ANTENNA. For example, highlight the white building, the parking lot, vegetation, etc. 

 
a. Remember, the closer you are zoomed in, the more precise your highlight will be. Try to 

get right near the antenna and highlight all of the pixels that surround it. 

 
b. You must be patient with this tool. It takes time to get it right! 
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21. Click the Apply button when satisfied. Pay close attention to the points on the tower antenna. 

Slowly, as you annotate more and more chunks, you will remove the noise from the antenna. 

 
22. Remove as much noise as time permits to derive the DPC of the communication tower. You may 

have to annotate several images before you are satisfied with the final results. 

 
 

5.4 The Processing Area 
 

In4.2, we noted that the extent of the DPC spread well beyond the communication tower. In this task, we 

will use the Processing Area tool to constrain the extent to just the tower itself. 

 
1. It’s best to reset our view to a zoom extent. This means we view the data from a top-down 

perspective and the zoom is extended as far out as the data exists. Hit the number 7 key on your 

keyboard to view the data from zoom extent. 

 
2. Without rotating the data, zoom in to your tower. Ensure that the tower is in the center portion of 

the data view. 

 
3. Click the New Processing Area button located under the Create toolbar. 
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4. Use left-click of your mouse and digitize your Processing Area around the extents of the 

communication tower. This is a subjective task. It is up to your judgment where the extents 

should start and stop. 

 
5. When you are satisfied with the extent of the Processing Area polygon, use the right-click of your 

mouse to close the polygon. Notice that any ATPs or points from the DPC which are beyond the 

extent of the Processing Area disappear! You have now constrained the extents of the project 

using the Processing Area. 

 
6. The Processing Area is 3-dimensional meaning it has a ceiling and a floor. Rotate the data in the 

data view to give yourself a 3D perspective. Notice the ceiling and floor. 

 
a. In your Properties Selection Window, you can adjust the ceiling and floor. Make a number of 

adjustments to your satisfaction. When done, click the Apply button to enable your adjustments. 

Be careful, if you set the ceiling/floor too high/low, you will “chop” off part of the communication 

tower! 

 
 
 

 
 
 

7. Just like any other layer, the Processing Area may be turned on or off by checking its box in the 

Layers Window. The Processing Area will remain active regardless if it’s turned on or off. 
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5.5 Generate 3D Textured Mesh Sub-Step 
 

In this part of the lab, we will assume you have spent the necessary amount of time performing Image 

Annotations and have established a Processing Area. With those tasks completed, you are able to 

re-generate a much higher quality 3DM. 

 
1. Click the Process tab to pull-down the various sub-steps and shortcuts. Select and click 

Generate 3D Textured Mesh. 

 
2. Ensure that you Click Save your changes. If you fail to save your changes, all of the previous work 

will be lost! 

 

 
 

3. Notice the processing progress bar at the bottom left of the screen. This is an indicator that the 

software is processing this and only this sub-step. This will save you hours of time instead of 

processing Step 2 all over again. 
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4. Once the processing is complete, check the box for layer Triangle Mesh. Observe the newly 

generated 3DM. 

 
5. How does the 3DM look? It should be constrained to the extent of your Processing Area. The 

quality should also be improved due to your Image Annotations. 

 
 

5.6 Deliverables & Conclusion 
 

The purpose of this lab was to develop the highest quality 3D Textured Mesh. Since the 3DM is a 

derivative of the DPC, we needed to perform an advanced manual classification technique known as 

Image Annotations. Lastly, we constrained the extent of the project with a Processing Area. 

 
Tip: It is advised that Image Annotations be used in combination with other manual classification tools 

discussed in L4 to develop the best DPC possible. Consequently, the latter will yield the best 3D 

Model. 

 
The final part to this lab will be to save the project with a personalized name. This will be your 

deliverable. 

 
1. Click the Project tab and select Save Project As… 

 
 

2. Ensure you are in your 02_Project directory. 
 
 

3. Give the project the name “Last Name_L5 and click the Save button. 
 
 

4. Allow Pix4Dmapper to save the project. Close Pix4Dmapper when complete. 
 
 

5. Navigate to your 02_Project folder for L5. 
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6. Select BOTH the *Last Name_L5.p4d file and folder. 
 
 

7. Right-click and select Send to -> Compressed to zip the files. 
 
 

 
8. Deliver your new *Last Name_L5.zip to your professor. 

 
 

9. This completes Lab 5. 
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Lab 6 
Measuring & Vector Tools 

 
Learning Objectives 

 
● Learn how to create lines and polygons 

● Understand 2D and 3D measurements 

● Comprehend vertex snapping techniques 

● Become familiarized with exporting vectors for use in 3rd party software 
 
 
 
 

Abstract 
 

Photogrammetry: The science of making measurements from photographs. When broken down, “photo” 

refers to light; “gram” refers to drawing; and “metry” refers to measure. 

While the deliverables produced from Pix4Dmapper can be loaded into 3rd party software, there are a few 

tools available that enable measuring. In this lab, we will explore how to derive linear and area 

measurements from the DPC. The measurements may also be used as vector data which may be 

imported into a 3rd party software. 
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6.1 The Data 
 

We will work with a pre-processed project. The project data and the images are located in the L6_Data.zip 

folder. 

 
1. Either by means of handoff from your professor or by direct download, copy the L6_Data.zip 

folder to your machines local hard drive. 
 
 

2. Open the L6_Data.zip folder and unzip or copy the L6 folder and paste it within *Your Last 

Name_Pix4D folder. 

 
3. Notice that the template folders are already in place. All of the images are within the 01_Images 

folder, and a .p4d file and folder named Measuring are within 02_Project folder. 
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6.2 Opening the Project 
 

Since we are given a pre-processed project, we will Open it instead of creating a New Project. 

 
1. Double-click the Measuring.p4d file to open the project directly. 

 
 

2. If prompted, ensure that you set the relative paths for the images. 
 
 

3. The Measuring project will open and will display the Map View. The project was flown near 

Albuquerque, NM. 

 
4. Click the rayCloud button to open the rayCloud view. It is important that we work with the DPC for 

this lab. 

 

 
 

5. Check the box for the Layer Point Clouds to visualize the DPC. 
 
 

6. Check the box for the Layer Cameras to turn the images off. 
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6.3 Creating Lines 
 

It is possible to create lines that serve as linear measurements in Pix4Dmapper. Each measurement will 

be saved as a vector. In Pix4Dmapper, vectors are known as objects. 

 
1. Locate the white and red cars in the center of the project. Notice this project is a mock car 

collision. Zoom in to the collision area. 

 
2. To the left of the white car, notice the yellow tape on the asphalt road. Before image collection, a 

tape measure was extended to 20 ft. We will measure it to confirm the length in the DPC. 

 

 
 

3. Zoom in close to the tape on the ground. Click the New Polyline button located in the Create 

toolbar at the top-left side of the screen. 

 

 
 
 

4. Move the mouse to the bottom end of the tape (near the paint stripe). Locate the end of the tape 

and left-click the location of the end of the tape in the DPC. Drag your mouse to the other end of 

the tape. Locate the end of the top side of the tape. Right-click the location of the end of the tape 
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in the DPC. This should create a green polyline that spans the length of the tape. 
 
 

 
 
 

5. If you left-clicked instead of right-clicked the top of the tape, you must right-click to end the line. 

There is no undo button in Pix4Dmapper. To undo the mistake, you must delete or remove the 

polyline from the map. Locate the Polyline 1 Layer under the Objects sections of the Layers 

Window. Right-click the Polyline 1 layer. Select Remove. The line will be deleted from the map. 

Click the New Polyline button again to recreate the polyline once more. 
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6. Take a look at the Properties Window. Under Selection, the measurement for the polyline is 

displayed. It was mentioned that the absolute length of the tape is 20 ft. The measurement 

displayed is roughly 6.1 meters. What does this mean? 

 

 
 

Since the units for this project are metric, we need to convert meters to feet to understand our 

measurements. There are 3.28 ft per 1 m. Therefore, to convert m to ft, multiply meters measured 

by 3.28. 

 
6.11 x 3.28 = 20.04 

 
This means the measurement of the tape in the DPC is accurate by 0.04 ft! Operator interpretation 

must also be taken into consideration when making measurements. 

 

6.4 Creating Areas 
 

It is possible to create polygons that serve as area measurements in Pix4Dmapper. Each measurement 

will be saved as a vector. 

 
1. Locate the New Surface button found in the Create toolbox. Click the New Surface button. Similar 

to the New Polyline technique, the next task is to identify an area and digitize an Object around it. 
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2. Move your mouse to the top-left corner of the white awning. Position your pointer so that you are 

snapped to the grass lawn just beyond the corner of the awning. Left-click your mouse to 

establish the first vertex of the polygon. Continue to identify the corners of the grass lawn just 

beyond the awning. The goal is to digitize vertices that establish the perimeter of the awning. To 

continue creating vertices, ensure that you left-click your mouse each time. 

 
3. When satisfied with the creation of the polygon, use the right-click button of the mouse to close 

the polygon. This technique should be applied to the very last vertex. 

 

 
 

4. Ensure that the vertices were established on the ground. As mentioned in 6.3, there is no undo 

button. If a mistake was made, simply remove the Object from Layers Window as described 

above. 

 
5. What is the measurement of the area you created? 

Note that the Length is the measured perimeter of the polygon. The Enclosed 2D Area is the area 

within the polygon and is measured as either meters or feet squared. 
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6. It is important to understand the difference between a 3D and 2D measurement as reported in 

Pix4Dmapper. 

 
a. A 2D measurement assumes all points lie along the same vertical plane; i.e., the 

reference from which points are snapped to (the DPC) is flat. If a line extends 50 ft up a 

vertical wall, the vertical portion of the line will not be accounted for when reporting the 

measurement. 

 
b. A 3D measurement does not make assumptions of vertex vertical positions. In the latter 

example, the vertical portion of the line will be accounted for when reporting the 

measurement. A rule of thumb is that 3D measurements are generally longer/larger than 

2D measurements. 
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6.5 Adjusting Vertices 
 

In Lab 6, the technique of digitizing vertices has been performed by snapping to the appropriate points 

found in the DPC. The precise adjustment (or movement) of vertices, however, is performed directly in the 

original images. This adjustment allows for a high level of precision since discrete features are easier to 

interpret this way. 

 
1. Locate Polyline 1 in the Layers Window. Click on the layer Polyline 1. The layer will become 

highlighted. The properties for the layer will be displayed in the Selection section of the Properties 

Window. Finally, the images that align with Polyline 1 will also display in the Images section of the 

Properties Window. 

 

 
 
 

2. Hover your mouse over the image with the name DJI_0496.jpg. Hit the spacebar on your 

keyboard to expand the image to the full screen. Notice the green line and Xs in the photo. Don’t 

they appear to be the same as the line you created? 

A: Yes. 
 
 

3. Roll your mouse over the green X to the right side of the green line. Notice that your pointer 

changes from a standard arrow to a movement arrow. Click and hold the left-click of your 

mouse. While holding, a yellow extension the green X is displayed as well as a yellow crosshair. 

The location that you position the yellow crosshair will determine the new location of the vertex. 

 
4. Repeat the latter to the green X on the left end of the green line. When finished, hit the spacebar 

to close the full extent of DJI_0496.jpg. 
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5. The vertices adjustment must occur in at least 2 images. Find image DJI_0509.jpg. Repeat the 

latter process to image DJI_0509.jpg. Ensure that the yellow crosshairs are positioned in the 

exact same location as the previous image. 

 
6. To practice, repeat this process on the next 5 images. 

 
 

7. When all adjustments are made, click the Apply button found in the Selection Window. The 

location of Polyline 1 will change in all of the images as well as in the DPC. 

 
8. Did your measurement change? 

A: Yes, by adjusting the position of the vertices the length of the line changes. 
 
 

9. To practice, perform steps 1-8 of this section to the layer Surface 1 to adjust the vertices of the 

polygon. 

 
 

6.6 Exporting Vectors 
 

The lines and polygons created in Pix4Dmapper may be exported as vector data for use in 3rd party 

software. 

 
1. Regardless of the amount of lines and polygons created, each one may be exported individually 

or all together. 

 
2. Locate the layer Polyline 1 in the Layer Window. Right-click the layer Polyline 1. Select the option 

Export… 
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3. An export window will open. It would be appropriate to save the files in the 02_Project folder for 

L6. Ensure that you have navigated to that folder. 
 
 

4. There are 4 file formats available to export vectors: shapefiles (.shp), CAD DXF (.dxf), 

Microstation DGN (,dgn), and GEarth KML (.kml). For this example, select .shp as these files will 

then open in a GIS software. You’re welcome to select any format desired from the dropdown, 

however. 

 
 
 

5. Name the file Polyline1. When finished, click the Save button. 
 
 

 
 
 
 
 

6. If you have not done so, create a random second polygon somewhere in the map. Ensure that you 

have layers names Surface 1 and another named Surface 2. 

 
7. Next we will export both/all of the polygons as one single file. Locate the layer Surfaces. Right-

click the layer Surfaces. Select the option Export All Surfaces… 
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8. In the export window, select.shp for the file format. Name the file All_Polygons. Click the Save 

button when finished. 
 
 

9. Open Windows Explorer. Navigate to the 02_Project folder in the L6 directory. There, you can find 

all of the shapefiles that were saved. 

 

 
 
 

10. Open a 3rd party GIS software. Import your shapefiles. Confirm they have the correct geometry 

and coordinates. 

All vectors created and exported from Pix4Dmapper are 3D shapes. That means they will maintain 

the vertical coordinates from which they are referenced from. 
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6.7 Deliverables & Conclusion 
 

In Lab 6, we learned how to create and export vector data. In addition, we used Pix4Dmapper to make 

measurements from the latter vectors. All vectors created maintain 3D properties as digitized in the 

software. 

 
1. Click the Project tab and select Save Project As… 

 
 

2. Ensure you are in your 02_Project directory. 
 
 

3. Give the project the name “Last Name_L6 and click the Save button. 
 
 

4. Allow Pix4Dmapper to save the project. Close Pix4Dmapper when complete. 
 
 

5. Navigate to your 02_Project folder for L6. 
 
 

6. Select BOTH the *Last Name_L6.p4d file and folder. 
 
 

7. Right-click and select Send to -> Compressed to zip the files. 
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8. Deliver your new *Last Name_L6.zip to your professor 
9.  
10. . 

 
 

11. This completes Lab 6. 
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Lab 7 
Volume Calculations 

 
Learning Objectives 

 
● Gain a fundamental understanding of cut and fill volume measurements 

● Learn how to create a base and compute a volume 

● Become familiar with base editing techniques and plane adjustments 

● Learn how to export and import bases for temporal applications 
 
 
 
 

Abstract 
 

In L6, we learned how to make linear and area measurements. Those measurements could be calculated 

in either 2D or 3D. When referring to 3D area, it is important to understand that while the vertices maintain 

vertical elevations, the measurement does not account for the volume. 

Pix4Dmapper does contain a toolset designed specifically to measure volumes. The workflow is quite 

simple: the user identifies what/where they want to measure by digitizing a polygon around the feature of 

interest. The polygon will act as a base from which Pix4Dmapper calculates the “material” (the data) 

either above or below the plane of the base. The corresponding terms are known as the cut and the fill 

respectively. See the graphic below. The bold flat black line represents the base: 

In order to know what the cut and fill volumes will be, Pix4Dmapper needs the DSM to be generated for 

reference. We will see in L8 that the DSM is a 3D elevation model. Therefore, Step 3 must be processed to 

gain access to the volume measurement tools in Pix4Dmapper. 
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7.1 The Data 
 

We will work with a pre-processed project. The project data and the images are located in the L7_Data.zip 

folder. 
 

1. Either by means of handoff from your professor or by direct download, copy the L7_Data.zip 

folder to your machines local hard drive. 

2. Open the L7_Data.zip folder and unzip or copy the L7 folder and paste it within *Your Last 

Name_Pix4D folder. 

3. Notice that the template folders are already in place. All of the images are within the 01_Images 

folder, and a .p4d file and folder named Volumes are within 02_Project folder. 
 

 

7.2 Opening the Project 
 

Since we are given a pre-processed project, we will Open it instead of creating a New Project. 
 

1. Double-click the Volumes.p4d file to open the project directly. 

2. If prompted, ensure that you set the relative paths for the images. 

3. The Volumes project will open and will display the Map View. The project is a quarry site 

that is near Lausanne, Switzerland. 
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4. Click the Volumes button to open the Volumes View. The software will take a few seconds to 

load the DPC. The DPC is used for snapping vertices of the base. Navigating in the Volumes View 

is the same as the rayCloud View. 

 
 

7.3 Creating a Base Surface 
 

Pix4Dmapper allows for multiple bases in one map. The technique of establishing a base is very similar to 

other digitizing techniques in the software. 

1. Each individual base must be identified by the user. Since this is a quarry, there are many cut and 

fill examples. For this lab, we will focus on set of stockpiles. 

2. Locate the black stockpiles on the East part of the map near the mill. We will focus on two piles. 
 

 
 
 

3. Zoom in close to the piles. 

4. Under the Objects Window, click the New Volume button. It looks like a cylinder with a + sign. 
 

 
 

5. Digitize a polygon around the extents of the piles. Do not worry if your polygon is imprecise. Left-

click the mouse to digitize the first vertex. Left-click the mouse to digitize additional vertices. 

When ready to close the polygon, right-click the mouse. 
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6. When finished, a green polygon will appear. This will serve as the base. 
 
 
 

7. Notice a Volume 1 dialogue is now present under the Objects Window. Click the Compute button. 
 

 
8. Give the software a few seconds to compute the cut and fill. When finished the volumes will be 

displayed. In addition, the volume constrained within the base will turn red in the DPC. The red 

volume indicates the location of where volume (either cut or fill) was calculated. 
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9. If the vertices were digitized just beyond the extent of the piles, then the majority of the volume 

should be cut (since piles sit above the base). If we performed this technique over an open pit, the 

majority of the volume would be fill. The Total Volume is difference between the cut and fill 

volumes. 

 
 

7.4 Editing the Base Vertices 
 

Mistakes may occur when digitizing a base. The result would be an imprecise polygon. The next section 

will demonstrate how to correct erroneous bases. 

1. Being as there is no undo button in Pix4Dmapper, a technique is to delete a base. This can be 

accomplished by clicking the trash button near the top right of the Volume 1 window. 

 
 

2. To edit without deleting, the technique would be to adjust the position of the base vertices. The 

default display of the vertices is quite small (they look like little green nodes). It helps to change 

the display of the vertices. 

 
 

3. Locate the Volume Settings button that appears as a small gear. Click the Volume Settings 

button. 
 

 
 

4. A Volume Settings dialog will display. Click the Display tab. Click and adjust the Vertex Radius 

slider all the way to the right. This will make each vertex display large. Click the Vertex Color. 

Choose a color different than green. Feel free to adjust any other Volume Settings you desire. 

Click OK when finished. 
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5. Notice the vertices of the base now have the properties as set. Click on one of the vertices one 

time. The outline of the base turns white. This means that you are about to move the position of 

the vertex. Now, click and hold the left-click on the same vertex as before. While holding, move 

the mouse to reposition the vertex. 

This technique takes practice. You may not get it right the first time but be patient! 
 
 
 

6. Once positioned, the volume measurements disappear and a new Compute button is displayed. 

Everytime a base is edited, the volume(s) will change making it necessary to recalculate. Click the 

Compute button. 

 
 

7. Try this technique over again to practice. 
 
 
 

7.5 Editing the Plane of the Base Surface 
 

Since every vertex is snapped to the DPC, the vertical elevation of the vertices creates a triangulated 

surface. This means that unless the DPC is 100% flat, the properties of the base plane will be somewhat 

screwed (i.e., not flat). There are several different base plane adjustments available in Pix4Dmapper. 

 
 

1. Open the Volume Settings for Volume 1 once more. Click the Base Surface tab. Each radio button 

provides a unique adjustment to the plane of the base. 
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a. The Triangulated is the default setting. This enables the base plane to take the 

triangulated properties mentioned above. 

b. The Fit Plane will remove the triangulation from the plane. This ensures the plane is 

planner but not necessarily flat and level. 

c. Align with Average Altitude will determine the average elevation for all vertices of the 

base. Pix4Dmapper will then adjust all of the vertices to the latter elevation. This ensures 

that the base plane is both flat and level. 

d. Align with Lowest Point will determine the elevation of the lowest vertex. The software 

will then adjust all of the vertices to the latter elevation. This ensures that the base plane 

is both flat and level. 

e. Align with Highest Point will determine the elevation of the highest vertex. The software 

will then adjust all of the vertices to the latter elevation. This ensures that the base plane 

is both flat and level. 

f. Custom Altitude is a numerical value set by the user. The software will then adjust all of 

the vertices to the latter elevation. This ensures that the base plane is both flat and level. 

 
 

2. For this example, click Custom Altitude and set the elevation to 530 m. Click OK. 
 

 
3. Notice that the base is floating above the piles. Click the Compute button to recalculate the new 

volume measurement. There should only be fill volume calculated. 
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Remember, the red display is the “material.” Can you think of a practical scenario where this 

example would apply? 
 

 
 
 

4. Adjust the base once more. Click Custom Altitude and set the elevation to 520 m. Click OK. 
 
 
 

5. Notice that the base is now resting below the piles. Click the Compute button to recalculate the 

new volume measurement. There should only be cut volume calculated. 

 
 

7.6 Exporting and Importing the Base Surface 
 

It is common that the same area needs to be calculated over time as material moves in and out of a site. 

This can be accomplished by saving the initial base and reusing in future projects. 

1. Locate the Export Base Surface(s) button under the Objects Window. Click the Export Base 

Surface(s) button 

 . 
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2. If you have established multiple bases, you can choose to export them individually or all at once. 

For this example, Click the Export button. 
 

 
 

3. A Windows Explorer window will display. There are many different file formats to export a base. 

From the dropdown, choose Shapefile .shp. Give the file the name Volume1. Ensure you are 

saving the file in the 02_Project folder. Click the Save button. Your base(s) is now saved as a 

polygon shapefile. 
 

 
4. To demonstrate the import function, we need to delete our existing Volume 1 from the map. 

Locate the Trash button and delete Volume 1. 

 
 

5. Locate the Import Base Surface(s) button and click it. 
 
 
 

6. In the Import Surfaces dialog, choose Volume1_surfaces.shp. Click Open. 
 

It is important to export bases as .shp because Pix4Dmapper can only import .shp. 
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7. Volume 1 should display in the map once more. Volume 1 will maintain all of the default vertices. 

This technique may be repeated over numerous flights of the same area to maintain a consistent 

base over time. 

 
 

7.7 Deliverables & Conclusion 
 

In  Lab  7, we learned how to create, edit/adjust, and import/export volumes measurements. There are 

numerous base plane property adjustments available in Pix4Dmapper. The import/export tools allow 

repeatable volume measurements over time. 

1. Click the Project tab and select Save Project As… 
 
 
 

2. Ensure you are in your 02_Project directory. 
 
 
 

3. Give the project the name “Last Name_L7 and click the Save button. 
 
 
 

4. Allow Pix4Dmapper to save the project. Close Pix4Dmapper when complete. 
 
 
 

5. Navigate to your 02_Project folder for L7. 
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6. Select BOTH the *Last Name_L7.p4d file and folder. 
 
 
 

7. Right-click and select Send to -> Compressed to zip the files. 
 

 
 

8. Deliver your new *Last Name_L7.zip to your professor. 
 
 
 

9. This completes Lab 7. 
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Lab 8 
Raster Deliverables 

 
Learning Objectives 

 
● Understand the definition of a raster deliverable 

● Comprehend the differences between a DSM and DTM 

● Become familiar with orthomosaic editing techniques 

● Become familiar with the various raster visualization options 

● Learn how to locate deliverables 
 
 
 
 

Abstract 
 
 

In Lab 4 we explored the dense point cloud. We understand the DPC, is not just a standalone 

deliverable, it is considered a “building block” from which numerous other deliverables are built 

from. In addition to the 3D Textured Mesh, the raster deliverables are derivatives of the DPC. 

 
Unlike the triangulated network that the 3D Textured Mesh is built from, rasters are interpolated “images 

files” Images contain rows and columns of pixels. Each pixel will have a digital number or DN value 

associated to it. The DN will commonly represent either a color value for a photo, or an elevation value for 

topography. 

In the geospatial lexicon, rasters that are in reference to a photo are known as orthophotos, 

orthomosaics, or simply orthos. Three components make up an ortho, 1) Photos are rectified meaning 

distortion is corrected in order to provide a geometrically accurate representation. 2) Multiple photos are 

mosaiced meaning the rectified photos are glued together to form one large photo-representation. 3) A 

uniform GSD is applied to the pixels of the orthomosaic. 
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Furthermore, rasters that are in reference to topography, are known as digital elevation models (DEMs). 

Interpolation of elevation occurs to a pixel when a direct elevation coordinate (from the DPC) is 

unavailable. DEMs are commonly used for one of two purposes, 1) When the elevation of the ground as 

well all of the above ground features need to be represented. This is known as a digital surface model 

(DSM). 2) When only the ground, or bare-earth, needs to be represented. This is known as a digital terrain 

model (DTM). 

During Step 3 processing, the ortho, DSM, and DTM are deliverables which the user can generate. These 

deliverables are commonly used in GIS software. In this lab, we will explore tools that edit/manipulate 

rasters. 

 
 
 
 

8.1 The Data 
 

We will work with a pre-processed project. The project data and the images are located in the L8_Data.zip 

folder. 

 
1. Either by means of handoff from your professor or by direct download, copy the L8_Data.zip 

folder to your machines local hard drive. 
 
 

2. Open the L8_Data.zip folder and unzip or copy the L8 folder and paste it within *Your Last 

Name_Pix4D folder. 

 
3. Notice that the template folders are already in place. All of the images are within the 01_Images 

folder, and a .p4d file and folder named Rasters are within 02_Project folder. 
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8.2 Opening the Project 
 

Since we are given a pre-processed project, we will Open it instead of creating a New Project. 

 
1. Double-click the Rasters.p4d file to open the project directly. 

 
 

2. If prompted, ensure that you set the relative paths for the images. 
 
 

3. The Raster project will open and will display the Map View. Notice that this project was flown in 

Richmond, CA. It is the same project used during L2. 

 
4. Click the Mosaic Editor button on the left side of the screen. This will enable the Mosaic Edit 

View. Give the software a few moments to refresh as it is loading your ortho. 



Licensed to : University, professor Copyright © 2019 Pix4D. All rights reserved 98  

 
 
 
 
 
 

5. After loading, the ortho will display in the data view. Use your mouse to zoom in and out. Click 

and hold the left-click to pan around the ortho. 
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8.3 Creating Regions 
 

Being that the ortho is an image, there are inherently places within it that contain artifacts. We will use the 

Regions tool to edit the artifacts. 

 
1. Zoom your mouse to the south-central portion of the ortho. Focus your eyes on the driveway that 

goes into the parking lot. Are there any artifacts that stand out? 

 
2. Notice that there is a white car that is driving into the parking lot. It appears as though there are 

two cars. But if you look closely, you see in reality that this is the same car. Also, the car(s) 

appear to have an odd transparency to them. This artifact is known as ghosting. 

 
a. When an object moves in reality, it becomes located in two or more positions in the 

image set. In other words, it is located in one position in one image, and another position 

in another image. The dynamic nature of a car in a parking lot makes them commonly 

susceptible to ghosting. 
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3. Under the Regions Window, click the Draw button. 
 
 

 
 
 
 

4. Move your mouse over the ghosted cars. Notice that your cursor changes from an arrow to a 

crosshair. Position your crosshair on the asphalt near the cars. Use the left-click of your mouse 

and begin to digitize vertices around both cars. Digitize a polygon around the extent of the cars. 

When finished with the polygon, use the right-click of your mouse to close the polygon. 

 

 
5. When you complete your Region the ghosted cars look much better! What happens here is that 

the software creates a patch of image content from one of the original images (before 

rectification) within the Region. 
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6. Notice the Images Window to the right side of the screen. Select image DJI_0007. The patch 

within your Region changes to display the image content from the image named DJI_0007. 

 

 
 
 
 

7. Regions are an excellent tool to remove or edit unwanted artifacts from the ortho. Create a 

number of additional Regions over artifacts you find. To do this, click the Draw button once more 

and follow the same procedure. 

 
 
 

8. To return to a specific Region and edit it after a number of other Regions have been established, 

select the drop-down from near the Draw button. Notice as you choose different Regions, they 

become selected in the Data View. It is possible to add and then edit as many Regions as one 

desires. 
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9. When satisfied with the Regions, it is important to save and export the new ortho. 
 
 

10. Click the Save button in the Export Window. Allow the software to save your work to the .p4d file. 

After the save is complete, click the Export button in the same window. Accept the dialogue. This 

will write a new ortho in a .tif format. The .tif can be found in the 3_dsm_ortho folder located in  

the parent project folder. 

 
WARNING: If you exit the software and fail to Save the ortho, the Regions will be lost all together. If 

you fail to Export the ortho, the Regions will be lost in the .tif. 

 
 
 

8.4 Visualizing the DSM 
 

In addition to the orthomosaic, Step 3 generates the DSM and DTM as raster formats. We will review 

different ways to visualize the DSM next. 

 
1. Locate the Mosaic Editor tab at the top of the screen. Click the tab and roll the mouse over the 

View option. A number of features are available to turn on and off by clicking them. In our 

example, Click the Show Regions and Show Edited Mosaic options to uncheck them. 
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2. While in the View menu, click the option Show DSM. The DSM will now be visualized instead of 

the orthomosaic. 
 

 
 
 

3. Now move your mouse over and click the Visualization option under the Mosaic Editor tab. This 

will check and enable the Visualization Window on the right side of the screen. 

 
 

 
 
 

4. Notice the histogram under the Band Information window. Since pixels in DEM rasters represent 

elevation values, the “image” is a single band. The Min and Max values are the lowest and highest 

points on the DSM respectively. The graph shows the full spectrum of pixels that make up the 

DSM raster, and plots the frequency of elevation values. The spike of pixels from 11-25 means 
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that most of the area has an elevation somewhere within that range. (In reality, this is a pretty flat 

public park)! 

 

 
 
 

5. Locate the Data Band range of values under the Color Mapping window. Here, we can establish a 

minimum to maximum range of elevation values in which to colorize. Set the minimum value to 

“11” (left side). Set the maximum value to “25 (right side).” Click the Update button found below 

the Apply window. Notice the DSM color changes. We have isolated the park to “pop” by 

constraining the elevation values that are appropriate to it.The large hill to the east of the park is 

much higher in elevation and therefore all values are displayed as the maximum (red). 
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6. Furthermore, the Palette may be adjusted to colorize the elevation values to a different 

preference. When Enabled, the Shading option enables a hillshade effect to the DEM. Lastly, the 

Ordering may be switched to display the elevation values from Min to Max, or Max to Min. 

 
7. Each time a Color Mapping option is changed, the Update button must be clicked for the changes 

to take effect. Adjust the Palette and select the option Spectral from the dropdown. Adjust the 

Ordering and select the option Max to Min. Click the Update button. Notice the changes to the 

DSM. Confirm your DSM looks like the following. Choose your own setting afterward to become 

familiar with the various Visualization settings. 

 
 

 

8.5 Visualizing the DTM 
 

As mentioned, the DSM represents the elevation of the ground as well all of the above ground features. 

To remove the above ground features from the model, the Processing Option called Raster DTM must be 

checked before running the process for Step 3. In this dataset, the DTM has already been processed and 

is ready to be visualized. 

 
1. Click the Mosaic Editor tab. Select View and then Check the option to Show DTM. The DTM is 

now visualized instead of the DSM. 

 
2. Notice the the Visualization options selected during the DSM section have all changed back to 

the default settings. The most obvious difference is that DTM is not being displayed as a 

hillshade. Find the Shading setting. Click the dropdown and select Enabled. Click the Update 

button. The DTM is now easier to recognize. 
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3. Continue to make adjustments to the Visualization settings for the DTM. Attempt to replicate the 

same settings as set for the DSM. 

 
4. Being that the removal of above ground features is an automated process, it would be 

appropriate to perform a quality check of the software’s performance of this task. The easiest 

way to do this is to locate a known feature on the map by toggling the view back to the 

orthomosaic. Once identified in the ortho, toggle the view to the DTM and see if the elevation is 

flat where the feature exists… 

 
a. Click the dropdown near the center of the screen to quickly toggle between rasters. 

Select Mosaic (group1). Your orthomosaic is now visualized. 
 
 

b.  One of the above ground features that stands out is the shed to the south of the road. 

Zoom in to the shed and focus on it. 
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c. Now click the top dropdown and select DSM. Hypothetically speaking, the DSM should 

show the elevation values for the shed and surrounding vegetation. Since we have 

isolated the elevation values in 8.4, the Palette will emphasize these features. 

 

 
 
 

d. Click the dropdown once more and select DTM. The shed and vegetation should be 

removed. The way to determine this, is that the footprint of the features should appear to 

be “flat” and have the same Palette color as the nearby bare-earth. The flat appearance is 

emphasized as large triangles on the ground as opposed to small ones that model the 

features. 
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e. Q: Did the software correctly remove the above ground features? 
 
 
 

A: The shed was correctly removed but the vegetation to the right was not. This is known 

because the vegetation has a distinct yellow color indicating that it is a higher elevation 

than the ground. In this example, the software was only effective at removing the shed. To 

confirm, you can toggle the ortho back on and visualize the vegetation. 

 
 

Since the DTM is a direct derivative of the DPC, it is important to revisit the DPC and 

manually classify the vegetation to its proper group in this example. To review how to 

classify the DPC manually, refer to L4. After this technique is performed, all of the rasters 

will need to be regenerated by re-processing Step 3. 
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8.6 Locating the Deliverables 
 

Deliverables are meant to be delivered and opened in 3rd party software. From there, further analysis or 

processing may be conducted. It is important to understand where the deliverable files are written so they 

may be accessed. 

 
1. As long as the user chooses to do so, deliverables are written as specific digital files. Files are 

written during the processing of a Step. For example: a .tif file that represents the orthomosaic 

will be written during the processing of Step 3. A series of different file formats are available to be 

written for the DPC during the processing of Step 2. 

 
2. Locate the Open Results Folder button on the top left side of the screen. Click the Open Results 

Folder. 

 
 

 
 
 

3. The windows File Explorer window will open. The folder path will be directed to the Project folder 

that was selected during the project setup. Folders are labeled according to the steps which have 

been processed. The naming convention is always the same: 

 
a. 1_inital - Contains files that the software relies on to align and orient the photos and the 

ATPs. Also contains the Quality Report. While this folder is necessary for Pix4Dmapper to 

work, there are no deliverables of significance located there. 

 
b. 2_densification - Contains the DPC and 3D Textured Mesh deliverables. 

 
 

c. 3_dsm_ortho - Contains all of the raster deliverables discussed in this lab. 
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4. Open the 3_dsm_ortho folder. Next, Open the 1_dsm folder. Notice all of the files. Copy and paste 

the files to another directory one your computer. It is important to copy all of the files and keep 

them together. 

 
5. Open a GIS software (like ArcMap). Load the TIF file of your DSM. You now have a functional GIS 

layer that may be analyzed! 

 
 

8.7 Deliverables & Conclusion 
 

The purpose of this lab was to work with raster deliverables. The orthomosaic can be edited by using the 

Regions toolset. The DSM and DTM can be visualized in a number of unique ways. Step 3 generates and 

writes the files for most of the deliverables that can be derived from Pix4Dmapper. 

 
1. Click the Project tab and select Save Project As… 

 
 

2. Ensure you are in your 02_Project directory. 
 
 

3. Give the project the name “Last Name_L8 and click the Save button. 
 
 

4. Allow Pix4Dmapper to save the project. Close Pix4Dmapper when complete. 
 
 

5. Navigate to your 02_Project folder for L8. 
 
 

6. Select BOTH the *Last Name_L8.p4d file and folder. 
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7. Right-click and select Send to -> Compressed to zip the files. 
 
 

 
 
 

8. Deliver your new *Last Name_L8.zip to your professor. 
 
 

9. This completes Lab 8. 
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